
 1 

How to Get Started on a ComfortAir Project Quickly 
Updated December 28, 2005 

 
Step 1: Select Input and Output Units, and Set Display Options 
If the current input and output units as displayed at the bottom of the left view window are not 
what you would like to work with, change either or both of them by using the Tools / Options 
menu item. Here, you can also set the display size and font size to get the best effect. 
 
Step 2: Enter General Project Data 
To start working on a project, select General Project Data from the Project menu, or click the 
corresponding button  on the toolbar. This starts the general data input wizard which will 
guide you through the first set of data input. After the ‘Finish’ button of this wizard is clicked, 
the data you entered (or edited) is incorporated into the project and ComfortAir is now ready to 
accept additional project data. ComfortAir automatically recalculates all results after each data 
entry or data editing action by the user. 
 
Step 3: Enter Additional Project Data 
The following Project menu commands and toolbar buttons will not be enabled until the general 
project data, as mentioned above in Step 2, has been entered. However, once the general project 
data is in, these commands and buttons can be used to enter (or edit) additional project data. 
 
Glass Windows Data or   Used to enter or edit glass windows data. ComfortAir then 

automatically recalculates all results. 
 
Walls and Roof Data or   Used to enter or edit walls and roof data. ComfortAir then 

automatically recalculates all results. 
 
Glass Blocks Data or   Used to enter or edit glass blocks data. ComfortAir then 

automatically recalculates all results. 
 
Other Building Data or   Used to enter or edit floor, ceiling, partitions and skylights 

data. ComfortAir then automatically recalculates all results. 
 
Step 4: View the Results 
When all the project data is entered, you can view the results by using the many commands 
under the View menu. Numerous tables, graphs and summary reports showing cooling loads, 
heating load and window shading results can be seen. There are also five toolbar buttons which 
give quick access to the five most important of these reports and graphs. These toolbar buttons 
are as follows: 
     to view the total cooling load graph 
     to view the total cooling load table 
     to view the peak cooling load report 

     to view the heating load report 
    to view all the project data entered by the user 

Hint:  To enlarge the view of any graph or report, use the mouse to drag the splitter window 
divider bar to the left. 
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For a more indepth discussion on the use of ComfortAir, see the Tutorial  below.You may also 
want to read the Overview on ComfortAir (Accessible from Help) to become more acquainted 
with what the application was designed to do. 
 

ComfortAir Tutorial 
 
This tutorial is intended to show how data for a project building is entered in ComfortAir and 
how the cooling, heating and glass shading results for the project are accessed and viewed. To 
follow this tutorial, it might be more convenient for you to first print all of it, then close your 
PDF viewer and leave your computer screen free to deal only with the running of ComfortAir. 
That way you can read the steps from the paper, carry them out on screen, without having to 
keep switching between ComfortAir and your PDF viewer. 
 
Sample Building Description. 
Our sample building to be used in this exercise, will be an imaginary two storey office building, 
located in Nagpur, India. See the sketch of the building below. The building is 120 feet long by 
50 feet wide, and each of the two storeys is 10 feet high. The walls of the building are made of 8 
inch concrete blocks with ½ inch cement mortar on the outside and 5/8 inch gypsum plaster on 
the inside. The roof is made of 4 inch concrete slab with a suspended ceiling made of ½ inch 
thick gypsum tiles. The building has glass windows on all four sides, externally shaded by fins 
and overhangs. Glass blocks amounting to 252 square feet form a portion of the northern wall on 
the ground floor. The building has a basement which goes to a depth of ten feet and is similar in 
area to the ground floor. The entire building including the basement is heated during the heating 
season, but only the ground floor and the first floor are cooled during the cooling season. More 
details about the building will be given as the exercise proceeds. We are required to carry out a 
heating and cooling load analysis of this building using ComfortAir. The actual loads which we 
will calculate are the block cooling load and block heating load for the entire building. 
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Step 1 – On Starting ComfortAir. 
ComfortAir has been started and you are looking at the two panes of a splitter window as shown 
in the ComfortAir Startup Screen below. Use a combination of Display Size and Font Size in the 
Tools/ Options menu to get the table on the right to look as close as possible to how it is shown 
in the screen shot. Both panes are almost blank. The left pane has the heading “KEY PROJECT 
INPUT VARIABLES” at the top, and the input and output units shown at the bottom. When the 
load analysis gets going, this pane will also show other important variables such as the project 
name and address, and the inside and outside design conditions. 
 

 
ComfortAir Startup Screen. 
 
The right pane of the splitter window will show the reports and graphs of the calculated results. 
At the moment it shows a blank table titled “Total Cooling Load”. The units used in both the left 
and the right panes of the view window are consistent with the output system of units set for the 
application as described below. 
 
Step 2 – Setting Input and Output Units, and Display Options. 
In this tutorial we will work in English units, both for input and output. If one or both units 
shown at the bottom of the left pane of the splitter window are not English units, change them as 
follows: 

(a) In the menu select Tools / Options. 
(b) When the Set Application Options dialog box appears, select English Input Units 
and English Output Units. 
(c) Select a combination of Display Size and Font Size which will make the table on the 
right fit neatly into the space and readable. 
(d) Click OK . A message appears on the screen informing you that “future projects will 
use these settings”. Click OK . 
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Step 3 – Entering General Project Data. 
On the toolbar, notice the  button. This button enables you to access the general data input 
wizard which will guide you through the process of entering the first set of data. However, don’t 
click that button just yet, because there are some issues you need to note before you move on. 
First, note that the four toolbar buttons to the immediate right of the  button are disabled. 
These four buttons are also data input buttons, but they are disabled now because the general 
project data must be entered before the data which is managed by these four other buttons. If you 
let the mouse cursor hover over each button for a short while, you will see what kind of data the 
button is used to enter. After each set of data is entered, ComfortAir automatically carries out 
recalculation of all the results. The general data is needed for all calculations; that is why it must 
be entered first. 
 
Now, have a look at the items under the Project menu. The five items you see are data entry 
commands corresponding to the five data entry toolbar buttons just discussed. At this time, only 
the first menu item, General Project Data, is enabled, and this is for the same reason that only 
the  button of the five data input toolbar buttons is enabled at this time. Having made those 
preliminary observations, we are now ready to enter the general project data for the sample 
building introduced earlier. 
 
From the Project menu choose General Project Data or click the  toolbar button. The 
General Project Data Input – Page 1 of 14 of the wizard appears. In the Project Name box type 
Sample Building, in the Project Designer box type your name, in the Project Address box type 
123 Some Street, Nagpur, India, and in the Date box type today’s date. 
 

 
General Project Data Input Wizard. 
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Next, select the weather station closest to the project building as follows. Expand the Weather 
Station tree control, scroll down to India and select Nagpur. Do not worry that the Current 
Weather Station indicator below the tree control is still not indicating your selection. This will 
not be registered until you have gone through all 14 pages of this wizard and clicked the ‘Finish’ 
button on the last page. If at some later stage you recall the general data wizard on this project, it 
will acknowledge this and all your other previous selections and entries. Look out for similar 
indicators for other data items as we proceed through this wizard. 
 
Note that each of the data entry dialogs in ComfortAir has a ‘Help’ button which you can use to 
access explanatory information on the entries for that dialog. 
 
Click on the ‘Next’ button to go to page 2 of the wizard. On this page you will choose from three 
frequency levels for cooling outside design temperatures, and from two frequency levels for 
heating outside design temperatures. Basically, these help to decide the summer and winter 
outside design temperatures for the project. Select the 1% cooling design temperature frequency 
and the 99% heating design temperature frequency. If you want to know more about these 
temperature frequencies, click the ‘Help’ button on this page of the wizard. 
 
Click the ‘Next’ button to go to page 3 of the wizard. On this page leave all the defaults as they 
are and click the ‘Next’ button to go to page 4. On page 4 select No 3 – 4 inch L.W. concrete as 
the roof construction. Then go to page 5. On page 5 leave all the default selections as they are 
and move on to page 6. Expand the Wall Construction Group Description tree control. Expand 
the L.W. and H.W. Concrete Block + (Finish) branch node and select D: 8 inch Block + Air 
Space or Insulation. Note that the selection of a wall construction group on this page and a roof 
construction group on a previous page is just to help ComfortAir decide the most appropriate 
CLTD data to load from your hard disk. At some later stage, in another step, you will enter more 
specific information for the roof and walls of the building. 
 
Click ‘Next’ to go to page 7. On this page you will select 7 as the hour when lights are turned on, 
twelve hours per day as the number of hours for which lights are on and 0.55 for the “a” 
classification of lights. To select the “b” classification for lights, expand the tree control and 
expand the ‘Floor Covered With Carpet and Rubber Pad’ branch node. Then expand the ‘ 
Medium Ventilation Rate’ branch node and select ‘C: 6 inch Concrete Floor’. Click the ‘Next’ 
button to go to page 8. Accept all the defaults in the ‘Lighting Load Schedule’. Enter 25,200 as 
the total installed fluorescent watts, leave the ballast factor as 1.2 and the incandescent watts as 
zero. These lights are for the ground and first floors, which represent the part of the building to 
be air conditioned. Incidentally, in a case where you do not know what the ballast factor is, just 
click on the ‘Help’ button and you will see a table which can give you some assistance. 
 
Click the ‘Next’ button to go to page 9. Select 8 as the hour when building occupancy starts, and 
10 hours as the total hours of occupancy. For the number of occupants, enter 200 in the category 
‘Very light work – Office, hotel, apartment’, and 40 in the category ‘Light work – Office, hotel, 
apartment’. Accept the default ventilation rates per occupant. 
 
Click the ‘Next’ button to go to page 10. Select 9 as the hour when hooded appliances are turned 
on, and 2 hours as the total operational hours of hooded appliances. In the ‘Hooded – Electric or 
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Steam Heated’ box type 80,000 as the manufacturer’s input rating in Btu / hr. Select 9 as the 
hour when unhooded appliances are turned on and 2 hours as the total operational hours of 
unhooded appliances. Enter 25,000 Btu / hr as the manufacturer’s input rating for the appliances 
categorised as ‘Unhooded – Electric or Steam Heated’. 
 
Click the ‘Next’ button to go to page 11. Select 8 as the hour when power equipment is turned 
on, and select 10 hours as the total operational hours for power equipment. In the category called 
‘Motor in, driven equipment in conditioned space or air stream’ enter 2 kW as the total installed 
motor kW. Accept the defaults for motor efficiency, load factor and use factor. Leave the other 
two categories of power equipment as zero kW for this building. 
 
Click ‘Next’ to go to page 12. Select 8 as the hour when electronic equipment (eg. computers) is 
turned on, and 10 hours as the total operational hours for electronic equipment. Enter 35 kW as 
the total power input for the electronic equipment and let the use factor remain as 80 %. 
 
Now, the infiltration rates for the sample building, in air changes per hour, for summer and 
winter will have to be estimated. Click on the ‘Help’ button and scroll down until you see a table 
which you can use to estimate the summer value. Scroll down some more and see the table to be 
used to estimate the winter value. The problem is that the use of these tables requires that you 
know the summer and winter outside design temperatures. Now, these temperatures are among 
the many items of data that ComfortAir is suppose to determine for you based on your selections 
and entries. But these ComfortAir determined data items will not be available until when you get 
to the end of this wizard and click the ‘Finish’ button. Therefore, close the Help file and accept 
the default infiltration rates for now. We will get back to this later. The building volume for the 
ground and first floors is 120 feet x 50 feet x 20 feet or 120,000 cubic feet. Enter this figure in 
the ‘Building Volume’ box. 
 
Click ‘Next’ to go to page 13. Select ‘K: ¼ inch Heat Absorbing Plate’ glass as the glass type 
used on the building envelope. Click ‘Next’ to go to page 14. This is the final page of the 
General Data Input wizard. Select ‘11: Medium Colored Closed Yarn’, for the interior shading 
device. In the lower group box, select the option ‘1: Glass With Interior Shading – Any Room 
Construction’. Click the ‘Finish’ button. ComfortAir carries out a calculation incorporating all 
the data just added. The ‘Total Cooling Load’ table is now filled with values, and the left pane of 
the view window shows the key input variables. But just before you start to relax, remember that 
we have some unfinished business regarding the infiltration rates. In the left pane of the view, 
note that the summer outside design dry bulb temperature for Nagpur is given as 108 F and the 
winter outside design dry bulb temperature is 55 F. With this information noted, reactivate the 
General Data Input wizard by selecting General Project Data from the Project menu, or by 
clicking the  toolbar button. Click the ‘Next’ button on each page until you get to page 12. 
While you are on the way, notice that all your previous entries are intact. On page 12 click the 
‘Help’ button. Scroll down to the first table. We will assume that the type of construction for our 
sample building is ‘medium’. For a summer outside design dry bulb temperature of 108 F the 
design infiltration rate is approximately 0.55 air changes per hour. Scroll down to the winter 
table. For a winter outside design dry bulb temperature of 55 F you can also use 0.55 air changes 
per hour as the infiltration rate. Exit the Help file and enter 0.55 air changes per hour as both the 
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summer and winter infiltration rates. Click ‘Next’ and then ‘Next’ again and then ‘Finish’ and 
you are through with the General Data Input. 
 
Notice that at this point, all the input toolbar buttons and all the data input menu items under the 
Project menu are enabled, allowing you to enter other project data. This is so because the 
general data is now in. This is a good time to save the work you have done so far. Choose an 
appropriate file name (such as Sample Building.Spc) and a directory and save your project using 

the File / Save command or the  toolbar button. 
 
At this point you could view some results, but you would have to bear in mind that the load 
analysis at this point is incomplete, since only a part of the total project data has been entered. 
However, to get an idea of what is happening so far, click on the  toolbar button to see the 
interim cooling load graph for the building. Then click the  button and then the  button to 
see the peak cooling load summary report and the heating report as they are up to this point. You 
can also click on the  button to see the data you have entered up to this point. 
 
Step 4 – Entering Glass Windows Data. 
Choose menu item Project / Glass Windows Data or click on the  toolbar button to start the  
Glass Windows Data Input wizard shown below. 
 

 
Glass Windows Data Input Wizard. 
 
Page 1 of the wizard is for windows on the north  orientation of the building. For our sample 
building these windows are shown in the drawing below. 
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In ComfortAir, glass windows are grouped into ‘Types’, where a type of windows consists of 
windows whose dimensions are similar in every way. There are six windows on the north 
orientation, labeled A to F on the drawing. A and D are similar in every way. They both have the 
same glass, fin and overhang dimensions. So we can treat them as one window type. Note that A 
and E are not similar because the height of the overhang above the glass is different for those 
windows. Likewise, B and C are not similar because the fin positioning is different for both. 
Windows E and F are similar in every way and therefore they will be seen as one type. 
 
Now that we understand the convention used to group windows, let us enter the window data for 
the north orientation. The following table shows the window parameter values for the various 
window types on this orientation. All dimensions are in feet. If you want to see the definitions of 
the parameters on a diagram, click the ‘Help’ button. To reduce clutter, I have deliberately not 
included dimension lines on the drawings in this tutorial. However, this should not be such a big 
problem, as I have given you the relevant dimensions in tables such as the one below. 
 
North Windows Parameters    Window Types 
            A and D B C      E and F 
Window Height, Wh     6 6 6 6 
Window Width, Ww     14 24 24 14 
Left Fin Distance From Window, Ld   1 8 50 1 
Right Fin Distance From Window, Rd  1 50 8 1 
Overhang Width, Vw     2 2 2 2 
Overhang Height Above Window, Vh  2 2 2 12 
Left Fin Width, Lw     2 2 2 2 
Right Fin Width, Rw     2 2 2 2 
Number of Windows     2 1 1 2 
 
In the page 1 dialog, enter the values from the column headed ‘A and D’ in the table above. You 
can use the Tab key to move from field to field. When you have finished, click the ‘Add’ button. 
The values are transferred to the list control at the bottom of the page and designated  
‘Type 1’. We now come to the column headed ‘B’. Notice that although there are no fins 
architecturally related to window B, there is still a fin to the left and a fin to the right of the glass. 
Architecturally, these fins are the right fin of window A and the left fin of window D, which are 
8 feet and 50 feet from B, respectively. It may be that because of the large distances that separate 
these fins from window B, they will at no time have any shading effect on window B. However, 
one is never sure, and to be safe it is best to give all the facts to ComfortAir and let it work out 
the details. So, we enter all the values under column ‘B’ above and click the ‘Add’ button. These 
values are also transferred to the list control and they are designated as ‘Type 2’. Similarly, add 
the values in the last two columns of the table above, and ComfortAir will designate them as 
‘Type 3’ and ‘Type 4’, respectively. 
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Check all the values in the list control to make sure they agree with those given in the table 
above. Scroll to the right in order to see those values to the far right of the list control, then scroll 
back to the extreme left. If after scrolling, some of the text in the list control appears a little 
distorted, click on the ‘Refresh’ button to redraw the text. If you find that you have made an error 
in entering any of the window values, use the mouse to select the relevant window in the  
‘Type’ column of the list control. Then click on the ‘Edit’ button and change the incorrect 
value(s). When you are satisfied that the values are correct, click the ‘Update’ button. 
 
Click the ‘Next’ button to go to page 2 of the wizard. This page is for north east windows, and 
since we do not have a north east orientation on our sample building, click ‘Next’ again to go to 
page 3 which deals with east windows. 
 
 

   
 
The window values for this orientation are as given in the table below. Enter them as you have 
done for the previous orientation. 
 
East Windows Parameters      Window Types 
        A B C D 
Window Height, Wh      6 6 6 6 
Window Width, Ww      14 14 14 14 
Left Fin Distance From Window, Ld    0 1 0 1 
Right Fin Distance From Window, Rd   1 0 1 0 
Overhang Width, Vw      2 2 2 2 
Overhang Height Above Window, Vh   2 2 12 12 
Left Fin Width, Lw      0 2 0 2 
Right Fin Width, Rw      2 0 2 0 
Number of Windows      1 1 1 1 
 
Click the ‘Next’ button to go to page 4 of the wizard. This page is for south east windows, and 
since we do not have a south east orientation on our sample building, click ‘Next’ again to go to 
page 5 which deals with south windows. 
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The window values for this orientation are as given in the table below. Enter them as you have 
done for previous orientations. 
 
South Windows Parameters     Window Types 

A and D B  C E and F Door 
Window Height, Wh         6  6   6         6    7 
Window Width, Ww       14           24 24       14    6 
Left Fin Distance From Window, Ld        1  8 50         1  38 
Right Fin Distance From Window, Rd     1           50   8         1  38 
Overhang Width, Vw         2  2   2         2    6 
Overhang Height Above Window, Vh     2  2   2       12    2 
Left Fin Width, Lw         2  2   2         2    2 
Right Fin Width, Rw         2  2   2         2    2 
Number of Windows         2  1   1         2    1 
 
Click the ‘Next’ button to go to page 6 of the wizard. This page is for south west windows, and 
since we do not have a south west orientation on our sample building, click ‘Next’ again to go to 
page 7 which deals with west windows. 
 

   
 
The window values for this orientation are as given in the table below. Enter them as you have 
done for previous orientations. 
 
West Windows Parameters             Window Types 
         A B C D 
Window Height, Wh       6 6 6 6 
Window Width, Ww                14        14        14        14 
Left Fin Distance From Window, Ld     0 1 0 1 
Right Fin Distance From Window, Rd    1 0 1 0 
Overhang Width, Vw       2 2 2 2 
Overhang Height Above Window, Vh    2 2 12 12 
Left Fin Width, Lw       0 2 0 2 
Right Fin Width, Rw       2 0 2 0 
Number of Windows       1 1 1 1 
 
When all the window data in the table above is added, click the ‘Next’ button to go to the 8th 
page of the wizard. Click the ‘Finish’ button to close the wizard and register all your inputs. 
Once again ComfortAir carries out a recalculation of all results and updates all views. This is a 
good time to save your work again and go on to enter the third set of data. 
 
 



 11 

Step 5 – Entering Walls and Roof Data. 
Choose menu item Project / Walls and Roof Data or click on the  toolbar button to activate 
the ‘External Walls and Roof Input Data’ dialog box. 
 

 
External Walls and Roof Data Dialog 
 
The four sides of the sample building are here presented again for your convenience. 
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The North wall net area is equal to the Gross Area – Glass Area – Glass Blocks Area. 
Therefore, North wall net area = (120 x 20) – (4 x 6 x 14) – (2 x 6 x 24) – (6 x 42) = 1524 Sq Ft. 
 
Similarly, 
East wall net area = 664 Sq Ft. 
South wall net area = 1734 Sq Ft. 
West wall net area = 664 Sq Ft. 
 
Enter these areas in the appropriate boxes in the dialog. Next, we need to determine the summer 
and winter U-Values for the walls. All four walls are made of 8 inch concrete blocks, with ½ 
inch cement mortar on the outside, and 5/8 inch gypsum plaster with vermiculite aggregate on 
the inside. Normally, if you know what these U-Values are you can just enter them in the 
appropriate boxes. However, if you do not know what they are and would like to calculate them, 
proceed as follows. 
 
To calculate the summer U-Value for the north wall, click the button labeled ‘N Wall Sum’. The 
U-Value Calculator appears. Click the ‘Next’ button of the U-Value Calculator until you come to 
page 3. Select the ‘Cement Mortar’ check box and enter the thickness of 0.5 inch in the box next 
to it. Click ‘Next’ to go to page 4. Select the check box labeled ‘8 inch Sand and Gravel 
Aggregate’ concrete block. Make sure that the number of layers for this selection is 1. Click  
‘Next’ to go to page 5. Under the ‘Gypsum Plaster’ heading, select the check box labeled  
‘Vermiculite Aggregate’ and enter 0.625 inch as the thickness. Click ‘Next’ twice to go to page 
7. Here you will select the air films on the inside and outside surfaces of the wall. Select the 
check box labeled ‘Still Air, Vertical Position, Heat Flow Horizontal’ and make sure the number 
of films for this is 1. This is for the inside air film. Then just below it, select the check box 
labeled ‘7.5 MPH Wind, Heat Flow in Any Direction’. This is for the outside air film under 
summer conditions. That completes the selections and entries for this calculation.  
 
Click ‘Next’, then the ‘Finish’ button. The U-Value is shown as 0.3986 Btu / (Hr. Sq Ft. F). 
Click OK to close the latest dialog box and return to the External Wall and Roof Input Data 
dialog. The U-Value appears in the box beside the north wall net area. Trim off all the decimal 
places from the fifth to the right end, leaving the U-Value as 0.3986. Use this value as the 
summer U-Value for the other three walls also, that is, east, south and west. 
 
To calculate the winter U-Value for the north wall, click the button labeled ‘N Wall Win’. When 
the U-Value Calculator appears, make the same selections and entries as you did to calculate the 
summer value, except that on page 7, instead of selecting the 7.5 MPH wind, select the 15 MPH 
wind for the outside air film. Click ‘Next’ then ‘Finish’ and see a winter U-Value of 0.4117 Btu / 
(Hr. Sq Ft. F). Click OK to close the latest dialog box and return to the External Wall and Roof 
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Input Data dialog. Again, trim the value appearing in the edit box to leave only the first four 
decimal places. Also, use this value for the winter U-Value of the other three walls. 
 
Now we come to the roof. The net area of the roof is 120 feet x 50 feet = 6,000 Sq. Ft. Enter that 
area in the box provided. To calculate the summer U-Value for the roof, click the button labeled 
‘Roof Sum’ and the U-Value calculator starts. On page 1, select ‘1/2 inch Gypsum or Plaster 
Board’ and make sure the number of layers is 1.This represents the suspended ceiling. Click the 
‘Next’ button twice to go to page 3. Under the heading ‘Concrete’ select ‘Sand and Gravel or 
Stone Aggr’ and enter a thickness of 4 inches. This represents the roof slab. Click ‘Next’ four 
times to go to page 7. Under the heading ‘Air Films’ select ‘Still Air, Horizontal Position, Heat 
Flow Down’. This is for the inside air film. Accept the default number of films given as 1. Then, 
select ‘7.5 MPH Wind, Heat Flow in Any Direction’ This is for the outside air film under 
summer conditions. Under the heading ‘Roof Air Space’ select ‘Horizontal, Heat Flow Down’. 
Click the ‘Next’ button and then the ‘Finish’ button. The roof summer U-Value is calculated and 
the result given as 0.3666 Btu / (Hr. Sq Ft. F). Click OK and round off the value in the roof 
summer U-Value edit box to 0.3666. 
 
To calculate the roof winter U-Value, click the button labeled ‘Roof Win’ to start the U-Value 
calculator again. Make the same selections and entries on the first and third pages of the 
calculator as you did for the previous calculation. Then, click the ‘Next’ button repeatedly until 
you get to page 7. Under the heading ‘Air Films’ select ‘Still Air, Horizontal Position, Heat Flow 
Up’. Let the number of films remain as 1. This is for the inside air film. Select the 15 MPH 
Wind, Heat Flow in Any Direction’ check box. This is for the outside air film under winter 
conditions. Under the heading ‘Roof Air Space’ select ‘Horizontal, Heat Flow Up’. Click the 
‘Next’ button and then the ‘Finish’ button. The roof winter U-Value is given as 0.4153 Btu / (Hr. 
Sq Ft. F). Click OK and round off the value in the roof winter U-Value edit box to 0.4153. 
 
Now, we have to deal with the walls below grade for heating purposes. The total area for the 
walls below grade is (120 + 50) x 2 x 10 = 3,400 Sq. Ft. Enter this area in the appropriate edit 
box. Enter a ground temperature of 61 F. We will now calculate the winter U-Value for the walls 
below grade. Assume the walls are made of 8 inch concrete blocks with 5/8 inch of gypsum 
plaster on the inside surface. Click the ‘BG Walls Win’ button to start the U-Value calculator. 
Click the ‘Next’ button three times to go to page 4 of the calculator. Under the heading ‘ 
Concrete Block, 3 Oval Core’ select ‘8 inch Sand and Gravel Aggregate’ and let the number of 
layers remain at 1. Click ‘Next’ once to go to page 5, and under the ‘Gypsum Plaster’ heading 
select ‘Vermiculite Aggregate’ and enter a thickness of 0.625 inch. Click ‘Next’ twice to go to 
page 7. Select ‘Still Air, Vertical Position, Heat Flow Horizontal’ under the ‘Air Films’ heading 
and let the number of films remain as 1. This is for the inside air film. Since there is soil on the 
outside of the wall below grade, there is no outside air film to select. Click ‘Next’ and then 
‘Finish’. The U-Value is given as 0.4632 Btu / (Hr. Sq Ft. F). Click OK and round off the value 
in the edit box to the first four places of decimal, that is, 0.4632.  
 
That completes the entries for the walls and roof. Click OK on the ‘External Walls and Roof 
Input Data’ dialog box to close it. The values entered on the dialog are now part of the 
application database. As usual, ComfortAir does a recalculation automatically and updates all 
results. Save your work again at this point. 
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Step 6 – Entering Glass Blocks Data. 
Let us now deal with glass blocks data. From the Project menu, select Glass Blocks Data or 
click the  toolbar button. The ‘Glass Block Walls Data’ dialog box appears. The only side of 
our sample building that has glass blocks is the north orientation, and the area of the glass block 
wall here is 252 Sq Ft. Enter this area in the ‘North glass block walls’ edit box on the dialog. In 
the group box at the bottom of the dialog, the default selection is the ‘No Indoor Shade’ radio 
button. For our sample building, leave that selection as it is. See screen shot below. 
 

 
Glass Block Data Input Dialog 
 
Click OK to close the dialog. ComfortAir carries out a recalculation and updates all results. Save 
your work again at this point. 
 
Step 7 – Entering Other Building Data. 
The term ‘other building data’ here means data concerning all building elements which have not 
been considered under previous categories. These elements include floors, ceilings, partitions 
and skylights. To begin the data entry for these elements, select menu item Project / Other 
Building Data or click the  toolbar button. The ‘Floor, Ceiling, Partitions and Skylights Input 
Data’ dialog box appears and it is shown below. 
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Floors, Ceiling, Partitions and Skylights Input Dialog 
 
Notice that ComfortAir has suggested various summer and winter temperature differences to be 
applied to floors, ceiling, etc. These values were calculated using the weather data for the locality 
and the design inside temperatures as inputs. They are reasonable assumptions, but you can 
accept them or change them as you wish. However, for this tutorial we will accept them as they 
are, except for a minor change which will be described shortly. 
 
The area of the floor at grade level is 120 feet x 50 feet = 6,000 Sq Ft. Enter this area in the top 
left edit box on the dialog. Since the basement of the sample building is not cooled, the floor at 
grade level will border the conditioned space and the summer U-Value for this floor will be used. 
However, because the basement is heated in winter together with the rest of the building, the 
winter U-Value for the floor at grade level should be left as zero and the winter temperature 
difference changed to zero. This is because for heating purposes, the floor slab at grade level is 
actually within the conditioned space, not bordering the space. Any one of these zeros will 
ensure that no heat transfer is calculated for the area of that floor slab in winter. Calculate the 
summer U-Value for the floor slab at grade level by clicking the button labeled ‘Flr Sum’. When 
the U-Value calculator appears, click the ‘Next’ button twice to go to page 3. Under the 
‘Concrete’ heading, select the ‘Sand and Gravel or Stone Aggr’ check box. Enter 6 inches as the 
thickness. Click the ‘Next’ button four times to go to page 7. Under the ‘Air Films’ heading, 
select the check box labeled ‘Still Air, Horizontal Position, Heat Flow Up’. Enter 2 as the 
number of films, as there is still air on both sides of the floor slab. Click ‘Next’, then ‘Finish’ and 
read the floor summer U-Value as 0.5814 Btu / (Hr. Sq Ft. F). Click OK and round off the U-
Value to 0.5814 in the appropriate edit box. 
 
For our sample building, there are no ceilings, partitions, or skylights bordering the conditioned 
space. (The actual ceiling is considered integral with the roof which has already been dealt with). 



 16 

We now go to the section headed ‘Floor On or Below Grade (Heating Only)’ at the bottom of the 
dialog. Enter 6,000 Sq Ft as the area of the basement floor. Notice that the ground temperature is 
given as 61 F. This is the same value you entered as the ground temperature for the walls below 
grade in Step 5. Leave that as it is. To calculate the winter U-Value for the basement floor slab, 
click the button labeled ‘Flr Win’ near the bottom right corner of the dialog. When the U-Value 
calculator appears, click ‘Next’ twice to go to page 3. Under the heading ‘Concrete’, select ‘Sand 
and Gravel or Stone Aggr’ and enter 6 inches as the thickness. Click ‘Next’ four times to go to 
page 7. Select the second check box, that is the one labeled ‘Still Air, Horizontal Position, Heat 
Flow Down’. Let the number of films remain as 1. Click ‘Next’ and then ‘Finish’. Read the 
winter U-Value of the basement floor as 0.7042 Btu / (Hr. Sq Ft. F). Click OK and round off the 
value to 0.7042 in the appropriate edit box. 
 
To determine the perimeter factor for the floor on grade level, click the ‘Help’ button and scroll 
down to the first table. The winter outside design temperature for this project is 55 F and the 
highest winter design temperature referred to by this table is plus 20 F. For a design temperature 
of 20 F and an edge insulation with R = 2.5 the perimeter factor is 40 Btu / (Hr. Ft). Assume a 
value of about 20 for a winter outside design temperature of 55 F. Close the Help file and enter 
20 as the perimeter factor. The exposed slab perimeter for the floor at grade level is the entire 
perimeter of the slab, since there is no other building adjoining our sample building. Enter 340 
feet as this perimeter. Click OK to close the dialog, and ComfortAir once again, does a 
recalculation and updates all results. Save your work. 
 
You have now completed the data entry for the sample building and ComfortAir has completed 
the load calculations and analysis. It is time to view the results. 
 
Step 8 – Viewing the Load Analysis Results. 
ComfortAir being an hourly load analysis program and not just a peak load calculation program, 
is rich in the number and diversity of output reports and graphs which can be viewed. In this step 
we will be looking at, not all, but just a small sample of the output information on our project 
building. ComfortAir shows results in two formats – reports and graphs. A report can either be a 
summary report for peak conditions, or a tabular report showing loads or sunlit glass areas for all 
hours of the day and for all months. For every tabular report there is a corresponding graph. All 
of the reports and graphs are accessible from the View menu. There are also five toolbar buttons 
which give quick access to the five most important of these reports and graphs. These toolbar 
buttons are as follows: 
 
  – to view the total cooling load graph 
  – to view the total cooling load table 
  – to view the peak cooling load report 

  – to view the heating load report 
 – to view all the project data entered by the user 

 
Click each of these toolbar buttons in turn and examine the information presented in the right 
pane of the splitter view window. At the bottom of the Peak Cooling Load Report you can see 
that the peak cooling load for the building is 59.37 tons, and at the bottom of the Heating Load 
Report note that the total heat loss is 268,220.38 Btu / Hr. 
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The Total Cooling Load Graph for the first six months looks like the following screen shot. 
Scroll down in the same view to see the graph for the other months. 
 

 
Total Cooling Load Graph 
 
Just in case you are wondering why we get negative values for the Infiltration and Ventilation 
latent heat gains, in the Peak Cooling Load Summary Report, here is the reason. The outside 
design summer conditions for Nagpur are 108 F dry bulb and 71 F wet bulb. If you locate this 
point on a psychrometric chart you will see that the outside relative humidity is about 15%. At 
the same time we are trying to maintain a relative humidity of 50% on the inside. Because the 
relative humidity on the inside is higher than that on the outside the latent heat gain from 
infiltration and ventilation will be negative. This situation occurs only in a small minority of 
cases. 
 
Tip:  To enlarge the view in the right pane, use the mouse to drag the splitter bar (the bar 
separating the left and right panes of the view window) well to the left. Also, if you want to print 

or print preview any of the graphs or reports, and the printer icon  on the toolbar and the File 
/ Print  and File / Print Preview commands are disabled, just click in the right pane of the view 
window to give that pane the focus, and the icon and all the print related commands will be 
enabled. 
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Now, expand the View menu and notice the six sets of results which can be viewed. These are 
the Cooling Tables, Cooling Graphs, Heating Report, Glass Shading Tables, Glass Shading 
Graphs, and Project Input Data. Four of these sets can also be expanded into subsets, and many 
of the subsets can be further expanded into sub-subsets. Place your mouse cursor over the 
Cooling Graphs submenu without clicking it. This expands into a long list of graphs headed by 
the Total Cooling Load graph. Click on the Roof Cooling Load menu item. A graph appears 
showing how the cooling load attributable to the roof varies with the hours of the day and the 
months. 
 
Spend some time exploring the many graphs and reports which can be viewed. My own favorite 
views are the graphs, but the tables are also useful for carrying out some kinds of analysis (such 
as ton-hour determination for a specific period). Enjoy. 
 


